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Version: 1.3

New Features

Bug Fixes

1



Programmatic API: Import and export scenes from the command line
or from languages such as Python or C++
Use the RoadRunner API service to control the RoadRunner UI programmatically. Using this API
service, you can:

• Create, load, and save RoadRunner scenes and projects.
• Import ASAM OpenDRIVE® files into scenes.
• Export scenes to one of the file formats that RoadRunner supports, such as ASAM OpenDRIVE,

USD, or Filmbox.

To get started using this API service, see these examples:

• “Convert RoadRunner Scenes Between Formats Programmatically”
• “Export Multiple RoadRunner Scenes Programmatically”

This API service is built using the open-source gRPC® framework. Using this framework, you can use
remote procedure call (RPC) methods to control RoadRunner in Python®, C++, or any other
programming language supported by gRPC. This figure shows a sample call from a Python client
application to load a RoadRunner scene.

For more details on the APIs, see “Control RoadRunner Programmatically Using gRPC APIs”.

The API service provides these RPC methods.

RPC Method Description
NewProject Create new RoadRunner project
LoadProject Load RoadRunner project
SaveProject Save RoadRunner project
NewScene Create new RoadRunner scene
LoadScene Load RoadRunner scene
SaveScene Save RoadRunner scene
Export Export RoadRunner scene
Import Import file into RoadRunner scene
Exit Exit RoadRunner application

Each RoadRunner installation includes a set of language-neutral protocol buffer (protobuf) files that
define the schema for the API service. This table shows the protobuf files for the service.
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Protobuf File Description
roadrunner_service.proto RoadRunner service protobuf schema
roadrunner_service_messages.proto RoadRunner service messages protobuf schema
import_settings.proto Import settings protobuf schema
export_settings.proto Export settings protobuf schema
geometry.proto Scene geometry protobuf schema

You can compile these protobuf files to generate the API code in various programming languages. For
more details, see “Compile Protocol Buffers for RoadRunner APIs”. Then, you can write language-
specific clients that call the generated API code. For sample clients, see these examples:

• “Create Python Client for Controlling RoadRunner Programmatically”
• “Create C++ Client for Controlling RoadRunner Programmatically”

Custom HD Map Formats: Import custom data into RoadRunner
Convert custom data into the RoadRunner HD Map data model and import your data into
RoadRunner. Each RoadRunner installation includes a set of language-neutral protocol buffer
(protobuf) files that define the schema for the RoadRunner HD Map data model. This table shows the
protobuf files for this data model.

Protobuf File Description
hd_map_header.proto RoadRunner HD Map header message
hd_map.proto RoadRunner HD Map message
hd_lanes.proto Lane representation messages for RoadRunner

HD Map
hd_lane_markings.proto Lane marking representation messages for

RoadRunner HD Map
hd_junctions.proto Junction representation messages for

RoadRunner HD Map
common_attributes.proto Common attributes for RoadRunner HD Map
geometry.proto Scene geometry protobuf schema

Use Python, C++, or any other programming language supported by protocol buffers to generate
RoadRunner HD Map files from custom data. For an example using C++, see “Import Custom Data
Using RoadRunner HD Map”.

Using the Scene Builder Tool, you can build a scene after importing a RoadRunner HD Map file. You
can then edit and export the scene to supported file formats, such as ASAM OpenDRIVE, USD, or
Filmbox. Use of the Scene Builder Tool requires a RoadRunner Scene Builder license.
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RoadRunner Asset Library Additions: Populate scenes with additional
US and German traffic signs, Japanese traffic signs, and additional
props and buildings
The “RoadRunner Asset Library Add-On” now includes hundreds of new assets. If you include the
RoadRunner Asset Library assets in your project, these assets appear in folders within the Library
Browser.

U.S. Signs

New US signs include emergency signs, school signs, and warning signs. These signs have been
organized into subfolders within the Signs folder of the Library Browser.

German and Japanese Signs

The Signs folder of the Library Browser includes new German traffic signs added to the Germany
subfolder and a new Japan subfolder for Japanese traffic signs.
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Extrusions

The Library Browser includes additional extrusion assets and their associated guardrail props and
textures.
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Props

The Library Browser includes additional environment and vegetation props. Additional levels of
detail have also been added to existing props.
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Buildings

The Library Browser includes additional buildings, such as homes in residential areas, a gas station,
a bus depot, and a school.
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OpenDRIVE 1.5 and ASAM OpenDRIVE 1.6 Support: Import and export
scenes using newly supported formats
You can now use RoadRunner to:

• Import scenes from OpenDRIVE® 1.5 and ASAM OpenDRIVE 1.6 files and convert them into
RoadRunner scenes.

• Export RoadRunner scenes to OpenDRIVE 1.5 and ASAM OpenDRIVE 1.6 files.

For information about the import and export capabilities, and limitations, see “Importing ASAM
OpenDRIVE Files” and “Export to ASAM OpenDRIVE”.

Scene Metadata: Add metadata to describe scene elements
RoadRunner now enables you to add metadata to describe the elements in a RoadRunner scene. You
can also use the metadata to set the value of ASAM OpenDRIVE attributes when you export the scene
to ASAM OpenDRIVE.

For details about how to add metadata, see “Add Metadata to RoadRunner Scene Elements”.

For an example of using metadata to set ASAM OpenDRIVE attributes, see “Set ASAM OpenDRIVE
Attributes Using Metadata”.
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SD Map Import: Build roads from imported Zenrin Japan Map API 3.0
(Itsumo NAVI API 3.0) SD data
You can now import Zenrin Japan Map API 3.0 (Itsumo NAVI API 3.0) 1 data and build roads using the
SD Map Viewer Tool.

This figure shows imported roads in the SD format.

This figure shows a scene built from this imported data.

1. To gain access to the Zenrin Japan Map API 3.0 (Itsumo NAVI API 3.0) service and get the required credentials (a client
ID and secret key), you must enter into a separate agreement with ZENRIN DataCom CO., LTD.
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This figure shows a close-up of the built roads. The scene includes overpasses where the elevation
information is available in the imported Zenrin Japan Map API 3.0 (Itsumo NAVI API 3.0) SD data.

R2021b

1-10



For an example of building roads by using Zenrin Japan Map API 3.0 (Itsumo NAVI API 3.0) data, see
“Build Roads by Using Zenrin Japan Map API 3.0 (Itsumo NAVI API 3.0) Data”.

TomTom HD Map Import: Build scenes from imported TomTom HD maps
(requires RoadRunner Scene Builder)
RoadRunner Scene Builder supports a pair of TomTom HD Map data formats: Avro (Format
Specification Version 1.2.0.0 and Schema Version 1.1) and GeoPackage. Use RoadRunner Scene
Builder to import road networks, road markings, barriers, and traffic signs from TomTom HD Map
data.

This figure shows a preview of the imported TomTom data.
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This figure shows a scene built from that data.
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This figure shows a close-up of the built data. The scene includes overpasses, and scene objects such
as guardrails.

 

1-13



For an example of building a scene from TomTom data, see “Build Scenes Using TomTom HD Map
Data”.

You can also customize which assets RoadRunner uses to display imported data. For more details, see
“Configure Assets for Imported TomTom HD Map Data”.

Edit the imported roads using RoadRunner and export the results to supported simulation and game
engine formats.

Use of the Scene Builder Tool requires a RoadRunner Scene Builder license.

ASAM OpenCRG Support: Import and export road surface data using
ASAM OpenCRG files
You can now import road surface data from ASAM OpenCRG® V1.2.0 file into a RoadRunner scene.
Use the Road CRG Tool to assign the specified data to a road segment in the scene and visualize
road surface variations using a colormap. For more details, see “Importing ASAM OpenCRG Files”.

You can also link and export road surface data using an ASAM OpenDRIVE file. For more details, see
“Export to ASAM OpenCRG”.

HD Map Route Creation and Build: Build routes from TomTom HD Map
and HERE HD Live Map data (requires RoadRunner Scene Builder)
The Scene Builder Tool now allows you to create routes, and select the roads and objects around
those routes to build them. For more details on creating routes for HD Map data, see “Create
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Routes”. Including the selective roads and objects along the created routes reduces the build time.
Previously, the Scene Builder Tool supported only roads and scene objects, with no option to define
the routes to build. For more details on scene building options, see “Build Scenes Using TomTom HD
Map Data” and “Build Scenes Using HERE HD Live Map Data”.

Building scenes using the Scene Builder Tool requires a RoadRunner Scene Builder license.

STL Import and Export: Import and export scenes using STL file format
Now you can import STL files into RoadRunner to create assets or scenes. You can also export road
scenes to the binary STL format. For more details, see “Export to STL”.

Selection Tool: Select roads and props in a scene as a group
Use the Selection Tool to select roads and props in a scene as a group.

Once you have selected an object, you can:

• Move the object group using the translation manipulators.
• Duplicate the object group using copy (Ctrl+C) and paste (Ctrl+V).
• Save the selected object group as a scene asset.

Scene Templates: Create scene asset templates from existing and
selected scenes
Create scene assets, which are collections of roads, intersections, props, and other 3D objects, and
add them to the Library Browser. Add scene assets to a project to quickly build up a complex
environments.
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From the Assets menu, select Assets > New > Scene Template to add the current scene, or
selected objects in the scene, as a template asset into a folder in the Library Browser of the current
project.

Translation Manipulators: Move objects precisely in x-, y-, and z-
directions
From the Tools menu, select Translate to show translation manipulators for selected objects. Use
these manipulators to precisely translate objects in a selected direction.

Lane Tool: Reverse lane travel direction
Use the Lane Tool to reverse the travel direction of the selected lanes.

R2021b
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You can select a lane or lanes and change the travel direction from forward to backward or backward
to forward. This option does not affect bidirectional and undirected lanes.
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Version: 1.2

New Features

Bug Fixes

2



Custom Level of Detail: Customize level of detail in exported scenes to
improve simulation performance
You can now customize the level of detail (LOD) used to render scenes that you export to simulators.
To access LOD settings, from the Tools menu, select LOD Settings. Using these settings, you can
reduce the level of detail at distances away from the simulator camera, where the reduction in scene
quality is acceptable. These modifications can improve simulation performance substantially. Export
of LODs is supported for FBX® files only. For more information on customizing levels of detail, see
Customize Levels of Detail in Exported Scenes. Examples of the changes you can make at these
distances away from the camera include:

• Reduce the amount of triangulation by modifying settings such as the positional tolerance. These
images show varying amounts of triangulation at different LODs.

Triangulation: High Level of Detail Triangulation: Low Level of Detail

• Flatten tiles containing roads and ground terrain into single texture images by selecting the
Overhead Tile Rendering option. These images show the difference in tile rendering at varying
LODs.

Tile Rendering Disabled Tile Rendering Enabled

• Combine, or pack, props in a tile into a single prop model by selecting the Pack Props option.
Prop packing reduces the number of textures needed to render props, at the expense of visual
quality.

R2021a
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Prop Packing Disabled Prop Packing Enabled

To verify that scene performance improves as you reduce the level of detail, you can visualize how
many draw calls the target simulators need to make to render the props. To view the draw calls, on
the View menu, select Draw Calls. These images show the difference in draw calls for a scene with
varying levels of detail. Each color represents a separate draw call.

Scene with High Number of Draw Calls Scene with Low Number of Draw Calls

Road Superelevation Tool: Manipulate banking angle along roads
Use the Road Superelevation Tool to control the superelevation (slope and banking angle) along
the entire length of a road.
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RoadRunner also supports the import of superelevation data from HERE HD Live Map by using the
Scene Builder Tool (requires RoadRunner Scene Builder).

Custom Export Configurations: Specify customized combinations of
file formats and scene data to export
In RoadRunner projects, you can now specify an XML file that enables the exporting of custom
formats. For example, you can specify a combination of file formats not available in the File menu,
under Export. You can also customize the type of data to export for each file format. For more details,
see Export Custom Formats.

Quality Checks: Identify additional issues to fix in your scenes using
built-in validation rules (requires RoadRunner Scene Builder)
The Scene Builder Tool now checks for quality issues in built scenes, including substantial changes
in elevation and lane boundaries that intersect with each other. These issues are displayed in the
Output window after you build the scene. Use these checks to identify whether these issues are
present in the source data from which you are importing.

Use of the Scene Builder Tool requires a RoadRunner Scene Builder license.

HERE Localization Data: Import signs, poles, and barriers from HERE
HD Live Map (requires RoadRunner Scene Builder)
The Scene Builder Tool can now import signs, poles, and barriers from the HERE HD Live Map
service. Previously, the tool imported only road networks.

R2021a
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You can use this scene data as landmarks when simulating localization algorithms. For an example of
building a scene that contains this data, see Build Scenes by Using HERE HD Live Map Data.

You can also customize what assets RoadRunner uses to display imported data. For more details, see
Configure Assets to Use for Imported HERE HD Live Map Data.

Use of the Scene Builder Tool requires a RoadRunner Scene Builder license.

Improved Cross-Sections: Create more accurate road cross-sections
that are compatible with OpenDRIVE importing and exporting
RoadRunner now models road cross-sections more accurately. The increased accuracy enables you to
import roads with complex cross-sections from OpenDRIVE. To manipulate these cross-sections, use
the Cross Section Tool. You can then export these roads back to OpenDRIVE or to another
simulator.

Sidewalk Height Tool: Modify sidewalk and curb heights
Use the Sidewalk Height Tool to modify the heights of sidewalks and curbs along a road. You can
modify sidewalk heights along the entire length of a road or at arbitrary points along a road.
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Light Source Parameters: Import and export parameters for
controlling traffic lights and streetlights
When you import FBX file assets containing light sources, RoadRunner now imports the parameters
that control the lighting effects. RoadRunner also exports this light data, enabling you to control
lighting effects such as brightness or color in the exported scenes. For more details on exporting FBX
files, see Export to FBX.
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New Features

Bug Fixes

3



RoadRunner Scene Builder: Automatically generate 3D road models
from HD maps
Use RoadRunner Scene Builder to import roads from HERE HD Live Map data.

Edit the imported roads using RoadRunner and export the results to supported simulation and game
engine formats.

Road Speed Limits Tool: Set varying speed limits along roads
Use the Road Speed Limits Tool to set varying speed limits along sections of a road. When you export
your scene to a simulator, you can use these values to test whether vehicles drive the set speed limits.

Bridge Span Creation: Fix bridge spans formed on elevated roads
In the Road Construction Tool, use the Auto Assign Bridges button to form bridge spans along
elevated roads. Use this tool to fix bridges in scenes where one road is elevated above another road.

Project Props to Terrain: Align prop curves with the surface terrain
In the Prop Curve Tool, use the Project to Terrain option to align props and extrusions with the
surface terrain rather than with the curve that you create. When you create prop curves, this option
is selected by default.

R2020b
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RoadRunner Editor: Interactive editor to model roads and 3D
environments
For details, see User Interface.

Intersections: Design complex intersections featuring merges, splits,
and traffic circles
For details, see Road Plan Tool.

Surface Damage: Add detailed road surfaces with lane markings,
stencils, and custom graphics
For details, see Surface Tool.

RoadRunner Asset Library: Library of prebuilt professionally created
assets
For details, see RoadRunner Asset Library.

Customize Road Signs: Combine text and graphics to build custom
signs
For details, see Sign Tool.

Traffic Signals: Edit signal phases and timing with the integrated
signal timeline and interactive controls
For details, see Signal Tool.

GIS Import: Import aerial imagery, elevation data, lidar point clouds,
and road maps to accurately represent physical locations in
RoadRunner
For details, see GIS Data Resources for RoadRunner.

OpenDRIVE Import and Export: Import and export road networks using
OpenDRIVE format
For details, see Importing OpenDRIVE Files and Exporting to OpenDRIVE.

Export to Apollo
RoadRunner can export road scenes to Baidu Apollo® formats. You can export to Apollo 3.0 and 5.0
XML formats and Apollo 5.0 binary format.

R2020a+
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For details, see Exporting to Apollo.

Export to Universal Scene Description (USD)
You can now export road scenes to USD. For details, see Exporting to USD.

Export for Metamoto simulations
You can now export road scenes for use in Metamoto® simulations. For details, see Exporting to
Metamoto.

Import from OpenDRIVE improved
Importing OpenDRIVE files is now faster.

Additionally, you can now import:

• Larger OpenDRIVE files
• Road types
• Speed limits
• Multiple road segments as one continuous lane
• Nonnumeric IDs
• Object types

For details, see Importing OpenDRIVE Files.

Export to OpenDRIVE improved
When exporting to OpenDRIVE, you can now export:

• Speed limits
• laneSection entries for the same RoadRunner road
• Object types
• U-turns

For details, see Exporting to OpenDRIVE.

Improved support for GIS assets
RoadRunner can now import geographic information system (GIS) data with earth-centric projection
information.

For GIS import information, see Importing GIS Data in RoadRunner.

Vector-type scaling
Dragging the Scale label on vector types scales all axes uniformly.
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